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Chapter 1. Introduction

This document describes the best practices for backing up and recovering IBM Flex
System"" and IBM® PureFlex" components.

A backup of the management software includes the following data:

* The management software image

* The local IBM Flex System Manager user registry

* IBM Flex System Manager configuration settings (including network settings)
* The list of discovered endpoints and inventory

* Configuration pattern data

Getting started

This section provides an overview of the order of operations for performing
backup and recovery of your IBM Flex Systems environment. Use this section as a
guideline for your backup and recovery process, or follow the links for more
information on how to backup and restore systems in your Flex environment.

1. Plan your backup and create a backup policy:

a. Determine the criteria for creating backups in your environment. For help,
see|“When to perform backups” on page 2|

b. Allocate sufficient time for creating backups. See [‘How much time to set|
[aside for backup” on page 2| for guidance.

C. Specify and document your file naming conventions. See [‘Determine fila
lnaming conventions for archives and backups” on page 5| for suggestions.

d. Ensure that the chassis to be backed up are being managed by an IBM Flex
System Manager. For instructions, see [“Making sure that the IBM FSM is|
[managing the chassis” on page 5.

2. Back up the components in your Flex Systems environment:

a. Print the [Backup checklist” on page 9/

b. Perform an inventory for all managed devices using the Flex System
Manager. This is described in [‘Making sure that the IBM FSM is managing]
[the chassis” on page 5.

c. Backup the IBM Flex System Manager and management software, as
described in [“Backing up the IBM FSM” on page 10)

d. Backup up the x-Architecture compute nodes as described in
[x86 Compute Nodes” on page 17

e. Backup Power systems compute nodes as described in [“Backing up Power]
[Systems compute nodes” on page 20|

f. Backup the Chassis Management Module (CMM) as described in |”Backina
[up the Chassis Management Module (CMM)” on page 16

g. Backup Top-of-Rack (ToR) SAN switches as described in

[top-of-rack switches” on page 23]

h. Backup Flex System Chassis Network switches as described in
[[/O modules” on page 22

i. Backup ITE operating systems and customer data according to your current
process.
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j. Archive the setup and configuration documentation for your Flex
environment. This usually includes, but is not limited to:
* Setup build sheets.
* Network configuration diagrams.
 PureFlex eConfig files, when applicable.

3. Restore your Flex environment from backups:

a. Determine whether your current environment is compatible with your
backups. See [“Restoring and version compatibility” on page 25 for
information on version compatibility.

b. Restore the management software image. See [‘Restoring the management
[software image” on page 25 for more information.

c. Perform inventory using the restored management software image. If the
existing environment does not match the information in the backup,
reconcile the environments by manually removing missing systems or
adding systems not included in the backup.

d. Restore the Chassis Management Module as described in |”Rest0ring tha
[Chassis Management Module (CMM)” on page 27|

e. Restore x-architecture compute nodes as described in |“Restoring;

[X-Architecture compute nodes” on page 28|

f. Restore Power systems compute nodes as described in [“Restoring Power]
[Systems compute nodes” on page 31)

g. Restore IBM V7000 storage nodes as described in [“Restoring the IBM Flex|
[System V7000 storage node” on page 32.

h. Restore I/O modules as described in|“Restoring I/O modules” on page 36

i. Restore ToR switches as described in [“Restoring up top-of-rack switches” on|
|o: e 38,

4. When you have restored all components, validate your system restoration as
described in the [Firmware Update Guides}

When to perform backups

In general, backups of IBM Flex System and IBM PureFlex System components
should occur whenever significant changes have been made to the configuration of
those components.

How much time to set aside for backup

The amount of time required to back up all IBM Flex System and IBM PureFlex
System components depends on the number of devices for which a backup needs
to be performed.

Backup does not affect the workload that is running in the chassis, including the
FSM. Unless I/O module intensive activities are running, the backup is generally
not disruptive. The examples in this section assume one unit of each type of
hardware and are intended to provide guidance on approximate times for planning
purposes.

Note: Configuration backup is straightforward. Backing up data volumes, such as

FSM or VIOS backups, may significantly impact the performance of the module.
For optimal performance, these types of backups should be run at off-peak hours.
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Example times for single-chassis backup

The table in this topic breaks down estimated backup times for single items.

Table 1. Estimated backup times for single-chassis components

Single item Estimated backup time (in minutes)
CMM settings 2

IMM settings 2

FSM appliance disks content (excluding 32

IMM settings)

FSM inventory data for visual reference 7
(chassis Map screen shot and html, full
inventory csv, logical networks csv, virtual
servers csv, VLAN csv)

Power ITE partition profile data 2
VIOS settings and data volume (viosbr / 1/17
backupios)

KVM virtual servers list and virtual 5

resources settings

ESXi virtual servers list and virtual resources |3
settings

vCenter inventory and virtual resources 2
settings

Ethernet chassis switch settings (EN4093)

2
Converged chassis switch settings (CN4093) |2
FC3171 SAN switch settings (QLogic) 2
FC5022 SAN switch settings (Brocade) 2

2
3
3

DVS 5000V virtual switch settings

Switch Center settings and data volume

Storwize & Flex V7000 settings (exclude
IMM settings)

Total (mins) 89

Example times for two-chassis backup

The table in this topic breaks down estimated backup times for items for two
chassis.
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Table 2. Estimated backup times for components in two chassis

Backup items

Two chassis (time in minutes)

Comments

CMM settings 2 32 One could write a
; script to invoke all of
MM settings 2 these backup tasks in
FSM appliance disks |32 parallel from the
content (exclude FSM. The total
IMM settings) duration would be
VIOS settings and 1/17 the longest task’s
data volume (viosbr time. Th('e FSM does
/ backupios) not prov1de.: either a
- script or a job
Storwize & Flex 3 schedule to perform
V7000 settings this function.
(exclude IMM
settings)
KVM virtual servers |5
list and virtual
resources settings
FSM inventory data |7 FSM GUI
for visual reference
(Chassis Map screen
shot & html, full
inventory csv, logical
networks csv, virtual
servers csv, VLAN
csv)
vCenter inventory 2 vCenter
and virtual resources
settings
ESXi virtual servers |3 vCLI
list and virtual
resources settings
Ethernet chassis 2 2 The Switch Center
switch settings has a GUI button you
(EN4093) can click to back up
Converged chassis 2 all O.f the §w1tches
. . configurations at
switch settings Th
(CN4093) once. the more.
switches that it is
DVS 5000V virtual 2 managing, the
switch settings greater the
time-saving potential.
Switch Center 3 SC
settings and data
volume
FC3171 SAN switch |4 Native Ul 2*n
settings (QLogic)
FC5022 SAN switch |4 Native Ul 2*n
settings (Brocade)
Total (mins) 89 57 Non disruptive

backup of entire
chassis
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Before you begin

If you are using an IBM Flex System Manager management node (IBM FSM) to
manage IBM Flex System and IBM PureFlex System, make sure that the IBM FSM
has discovered all managed devices and that you perform a full inventory of all
managed devices before you begin the backup process.

Determine file naming conventions for archives and backups

You should determine naming conventions for all files that you will generate
during the backup process. This will enable you to more quickly recover data
during the restoration process.

Note: The backup file is time-stamped, and renaming it is not recommended.
Some files, such as the FSM backup file that is stored on the HDD, cannot be
renamed.

Making sure that the IBM FSM is managing the chassis

If you have not already set up the IBM FSM to manage your chassis, complete the
following steps to manage a chassis, discover the operating systems for all
compute nodes, and gain full access to all resources being managed by the IBM
FSM (also known as managed endpoints).

Before you begin

Tip: If you do not know the IP address of the operating system on an
X-Architecture® compute node, you can determine it by selecting the compute
node on the Chassis Manager and selecting the common action Remote Access >
Remote Control to start a remote login session to the operating system and
determine the IP address.

Procedure
1. From the Home page, select the Initial Setup tab.
2. Follow Steps 2, 3, and 4 on the Initial Setup tab.
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3. Discover the operating systems for all compute nodes in the chassis. It is
important to discover the operating systems through the IBM FSM. Complete
the following steps for each compute node on which you installed an operating
system:

a. From the Plugins tab, locate the heading for Discovery Manager and click
System Discovery.

b. From the System Discovery wizard, select a discovery option, such as
Single IPv4 address.

Tip: Rather than type in a single address, you can choose to discover a
range of IP addresses, which will make the discovery process easier.

c. Enter the IP address of the operating system.
d. For the field Select the resource type to discover, select Operating System.
e. Click Discover Now.

For more information about discovering operating systems through the IBM
FSM, see the following website:

http:/ /publib.boulder.ibm.com /infocenter/flexsys/information / topic/|
com.ibm.director.discovery.helps.doc/|
fqm0_t_performing_system_discovery.html|

4. Make sure that you have access to all compute nodes and that the compute
nodes are unlocked. From the Chassis Manager, you can verify that you have
access to all compute nodes. If not, use the information provided at the
following website to request access from the IBM FSM:
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http:/ /publib.boulder.ibm.com /infocenter/flexsys/information /topic/|
com.ibm.acc.8731.doc/fgm0_t_requesting_access_to_a_secured_system.html|

Note: You can only perform this step if an operating system is not already
installed or if you are running VMware or Red Hat Enterprise Linux.

. After all components, including the operating systems, have been discovered,
perform a full inventory for all components in the chassis. Complete the
following steps to discover all components, including operating systems:

a. From the Plugins tab, locate the heading for Discovery Manager and click
View and Collect Inventory.

b. Under Target Systems, click Browse.

c. When the list is displayed, click Actions > Select All.
d. Click Add to add the systems to the selected area.
e. Click OK.
f. On the summary page, click Collect Inventory.
g. Select Run Now and click OK.

For more information about collecting inventory on components in a chassis,
see the following website:

http:/ /publib.boulder.ibm.com/infocenter/flexsys/information/topic/
com.ibm.director.discovery.helps.doc/fgm0_t_collecting_inventory.html

Chapter 1. Introduction 7


http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.8731.doc/fqm0_t_requesting_access_to_a_secured_system.html
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/com.ibm.acc.8731.doc/fqm0_t_requesting_access_to_a_secured_system.html
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/com.ibm.director.discovery.helps.doc/fqm0_t_collecting_inventory.html
http://publib.boulder.ibm.com/infocenter/flexsys/information/topic/com.ibm.director.discovery.helps.doc/fqm0_t_collecting_inventory.html

8 IBM Flex System and IBM PureFlex Backup and Restore Best Practices: Flex Version 1.3.0



Chapter 2. Backing up the system

When you back up the system, make sure that you back up the IBM FSM, all
chassis components, all top-of-rack switches, and all external storage devices.

Backup checklist

Use this checklist to ensure that you have backed up your entire system in the
correct order.

Important: It is recommended that all backed-up data be encrypted.

Table 3. Backup checklist

Step | Task name Description
1 Inventory Perform full system inventory on all managed
devices via the FSM.
2 IMM backup Capture, export, and archive for all IMMs.
3 System p — backup data profile |Backup the Profile Configuration via the FSM.
4 System p — backup VIOS Backup the VIOS configuration via the FSM.
5 CMM backup Capture, export, and archive all primary CMMs.
6 FSM Chassis Map — Graphical Capture, and archive a screenshot picture via
the FSM for each chassis managed.
7 FSM Chassis Map — Table View | Capture, export and archive the chassis map
table view csv files via the FSM for each chassis
managed.
8 FSM Resource Explorer — Full Capture, export (as html) and archive full
Inventory inventory using Resource Explorer.

9 FSM Resource Explorer — Logical | Capture, export and archive Logical Network
Networks & Members view using FSM Resource Explorer.

10 FSM Resource Explorer — Virtual |Capture, export and archive Virtual Servers and
Servers and Hosts Hosts view using FSM Resource Explorer.

11 FSM Resource Explorer — Capture, export and archive Systems by VLAN
Systems by VLAN and Subnet and Subnet view using FSM Resource Explorer.
12 FSM Full Backup Capture, export and archive the FSM Backup
using the FSM Administration functions.
13 Backup Top-of-Rack (ToR) SAN | Capture, export, and archive configuration data.
Switches

14 Backup Flex System Chassis Capture, export, and archive configuration data.
Integrated SAN Switches

15 Backup IBM Storwize V7000 Capture, export, and archive configuration data.

16 Backup Top-of-Rack (ToR) Capture, export and archive all Top-of-Rack
Network Switches Network switches.

17 Backup Flex System Chassis Capture, export, and archive all PureFlex
Network Switches Chassis integrated Network switches.

18 Backup ITE OS and Customer Use current backup procedures to validate
Data regular backups are being performed and

current for all systems.

© Copyright IBM Corp. 2013




Table 3. Backup checklist (continued)

Step | Task name Description
19 LBS/ITS Setup Buildsheets Archive any Lab Services or ITS Buildsheets that
were provided during initial setup.
20 Network Configuration if not on | Archive any Network Configuration data that is
Buildsheet not included in the LBS/ITS Buildsheets.
21 PureFlex eConfig files Archive any eConfig files that were used in the

ordering of the PureFlex HW. Human readable
output is preferable.

Saving the IBM PureFlex configuration files

If you purchased an IBM PureFlex system, save the eConfig files used to generate
the order and the setup buildsheets that were provided to you during initial
installation.

Note: An IBM PureFlex System can be ordered without IBM LBS. The buildsheets
or network diagrams are provided only if LBS services were included.

Saving setup buildsheets

An IBMPureFlex installation should be accompanied by build/configuration sheets
and network diagrams prepared by those who performed initial setup and
configuration.

Note: It is important to maintain these configuration and network diagrams on an
ongoing basis. Archive buildsheets that were provided during the initial setup.

Backing up the IBM FSM

When you back up the IBM FSM, make sure that you complete all procedures in
this section so that you can recreate the IBM FSM if you need to fully recover the
IBM FSM in the event of a disaster.

These procedures combined with the Backup/Recovery DVDs should enable you
to recreate your IBM FSM if required.

Capture the Chassis Manager view (optional)

For each chassis being managed by the IBM FSM, use a screen capture program to
capture the graphical view of the Chassis Manager. Make sure to select the
Hardware Status view. This screen capture will enable you to know the exact bay
locations for all devices in the chassis.

Note: This procedure is optional. It is useful in disaster recovery scenarios when it
is necessary to replace all hardware and set it up to look like the original.

Complete the following steps to capture the graphical view of the chassis manager.
1. Log in to the IBM FSM Web interface from a Web browser.
2. From the home page, select the Chassis Manager tab.

3. From the list of managed chassis, select a chassis by double-clicking on a
chassis name to display the graphical view.
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4. Make a screen capture of the Chassis Manager and save it to your backup
archive. Make sure that you name the file according to the previously
established file naming conventions.

Export the Chassis Manager table view (optional)

For each chassis being managed by the IBM FSM, export the table view and save
the file as part of your backup archive.

Note: This procedure is optional. It is useful in disaster recovery scenarios when it
is necessary to replace all hardware and set it up to look like the original.

Complete the following steps to export the table view.
1. From the Chassis Manager graphical view, click Table view.
2. Click Actions > Export.
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The file is saved as Chassis_Map.csv

3. Copy the file to the location where you are storing your archives. Make sure
that you name the file according to previously established file naming
conventions.
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Capture inventory data for the chassis (optional)

For each chassis being managed by the IBM FSM, capture the inventory data for
all devices in the chassis.

Note: This procedure is optional. It is useful in disaster recovery scenarios when it
is necessary to replace all hardware and set it up to look like the original.

Tip: Make sure that you have performed a full inventory on the chassis before
capturing the inventory data. See [‘Making sure that the IBM FSM is managing the|
Ichassis” on page 5| for details about performing a full inventory.

Complete the following steps to export the table view.
1. From the Chassis Manager graphical view, click the chassis itself.

2. In the Details section at the bottom of the page, click Show Advanced
Properties.

3. Click the Inventory tab to display the inventory for the chassis.
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4. Click Export All to display the Export Inventory page:

Export inventory data for the specified target systerns to a file, Select
the format to use whan exporting the data.

Format
| Hypertext Markup Languaga (HTML) ;I

['l-" Show summary in export

T show anly default colurmns in export

(s] 4 Cancel

5. Click OK to display the results in your Web browser:
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Save the HTML page. The default name is InventoryExport.html.

Copy the file to the location where you are storing your archives.

Export logical networks and members

For each chassis being managed by the IBM FSM, capture the logical networks
configuration.

Complete the following steps to export logical networks and members:

1.

2.

From the Chassis Manager, enter Logical Networks and Members in the find
field.
Select the Task tab and click Logical Networks and Members
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From the Logical Networks and Members page, click the Actions > Export :
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The file is saved as Logical_Networks_and_Members__View_Members_.csv
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4. Copy the file to the location where you are storing your archives. Make sure
that you name the file according to previously established file naming
conventions.

Export virtual servers and hosts

For each chassis being managed by the IBM FSM, capture the virtual server and
host configuration.

Complete the following steps to export virtual servers and hosts:
1. From the Chassis Manager, enter Virtual Servers and Hosts in the find field.
2. Select the Task tab and click Virtual Servers and Hosts
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3. From the Virtual Servers and Hosts page, click the Actions > Export :
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The file is saved as Virtual_Servers_and_Hosts.csv

4. Copy the file to the location where you are storing your archives. Make sure
that you name the file according to previously established file naming
conventions.

Export VLAN and Subnet configuration

For each chassis being managed by the IBM FSM, capture the VLAN and subnet
configuration.

Complete the following steps to export the VLAN and subnet configuration:

1. From the Chassis Manager, enter Systems by VLAN and Subnet in the find
field.

2. Select the Task tab and click Systems by VLAN and Subnet
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The file is saved as Systems_by_VLAN_and_Subnet.csv

4. Copy the file to the location where you are storing your archives. Make sure
that you name the file according to previously established file naming
conventions.

Back up the IBM FSM configuration
Create a backup of the IBM FSM configuration.

Before you begin

Note: This procedure applies to backing up the FSM configuration to secure FTP
(SFTP) server. IBM also support backup of the FSM configuration to a local hard
disk drive or USB drive. For more information, see [Restoring the management]

software image|

Make sure that the IBM FSM has network access to a secure FIP (SFTP) server.
Then complete the following steps to back up the IBM FSM image to the SFIP
server:

Run the smcli 1sjob -m command to determine whether there are active jobs.
Either terminate background jobs or wait for the jobs to terminate. The FSM
backup may not start or complete if other jobs are running.

Log on to the FSM via the CLI with an smadmin group user and run the backup
-e command to check uncompressed backup size. Then, prepare enough free space
for an sftp backup. The actual backup file size is less than the uncompressed
backup size.

Procedure

Important: Do not power off the IBM FSM management node while a backup
operation is in process. Otherwise, the backup will fail.
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1. From the Home page, click the Administration tab.

2. On the Administration tab under Serviceability tasks, click Backup and
Restore. The Backup and Restore page opens.

3. From the Backup and Restore page, click Backup Now. The Backup Now
window opens.

4. Select SFTP.

5. Enter the location on the SFTP server where the backup file should reside (you
must enter the SFTP server name as well).

Important: To back up the management software to an SFTP server, the
destination server must have Linux with Secure Shell (SSH) enabled.
Otherwise, the backup operation might fail.

6. Enter the User ID and password for the SFTP server (must have sufficient
permissions to write to the server).

7. Click OK.

What to do next

Additional information about backing up the IBM FSM is available at the following
location:

http:/ /publib.boulder.ibm.com/infocenter/ flexsys/information / topic /|
com.ibm.acc.8731.doc/backing up_frm.htmi|

Backing up chassis components

Make sure that you back up all component in the chassis.

Backing up the Chassis Management Module (CMM)
The CMM can be backed up through the CMM web interface.

Backing up the CMM through the GUI
Use the native CMM GUI to back up the CMM using the GUI method.

About this task

Note: It is important that you remember your FSM password, as it is required to
restore a backup.

Procedure

See [Saving a CMM configuration| for the steps in the procedure.

Back up the CMM through the CLI
The CMM can be backed up using the command-line interface of the CMM.

About this task

Note: By default, the CMM operates in secure mode. When the CMM is set to
secure, only the secure file transfer methods HTTPS and SFTP can be used for
firmware updates and other tasks involving file transfers, such as transferring a

backup configuration file to restore a configuration. The unsecure file transfer
protocols HTTP, FTP, and TFTP are disabled.
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Note: It is important that you remember your FSM password, as it is required to
restore a backup.

Assume that you have set up an SFTP server as follows:

* IP address: 191.168.1.101

* User ID: userid

e Password: xxxxxxxx

* Encryption Passphrase: b@ckupNOw (zero, not an uppercase o)
* Backup directory: /home/userid/backup

You are creating a backup of the primary CMM.
Procedure

Complete the following steps to back up the CMM configuration.

1. Using a secure protocol, such as SSH, log in to the CMM CLI interface using a
user ID that has Supervisor or Chassis Configuration authority.

2. At the system> prompt, enter the following command:

write -u sftp://userid:xxxxxxxx@192.168.1.101/home/userid/backup/cmmp.bkp
-p "b@ckupNOw" -T system:mm[p]

where:

* -u specifies the remote location to which the file will be written.

Note: You must enter the full destination path for the SFTP server in the
URL that you provide.

* -p specifies a double-quote delimited passphrase that will be needed to
restore the configuration file. Minimum passphrase length is 6 characters.
Maximum passphrase length is 31 characters.

* in mm[x], x is the primary CMM bay number.
If successful, the system responds with OK.

What to do next

Additional information about the CMM backup process and the CLI command
used to perform a backup is available:

* Saving a CMM Configuration

http:/ /publib.boulder.ibm.com /infocenter/flexsys/information /index.jsp?topic=|
%2Fcom.ibm.acc.cmm.doc%2Fsave_config_cmm.html|

* write command

http:/ /publib.boulder.ibm.com/infocenter/flexsys/information /index jsp?topic=|
%2Fcom.ibm.acc.cmm.doc%2Fcli_command_write.htmll

Backing up x86 Compute Nodes

To create a backup of the service processor (Integrated Management Module) on
x86 Compute Nodes, use either the IMM graphical user interface or the IMM
command-line interface. For operating system and user data, use standard backup
procedures.

You need to back up the IMM for every x86 Compute Node in your system.

Backing up the IMM through the graphical user interface
Follow this procedure to back up the IMM through the graphical user interface.
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About this task

Note: It is important that you remember your FSM password, as it is required to
restore a backup.

Procedure

Complete the following steps to back up the IMM for an X-Architecture compute
node:

1. From a Web browser, log in to the IMM graphical user interface for the
X-Architecture compute node.

2. From the user interface, click IMM Management > IMM Configuration.

IBM Integrated Management Module Il

RZ- Systern Status  Events=  Service and Support ~  Server Management~ | IMM Management = | -
IMM Properties YSE\OUE properties and settings related to the

IBM Flex System x240
Create and modify and view user accounts, and

Add System Descriptive Name Users view group profile far active directory users

The System Status and Health page provides an at-a-glance overview of the operating statl yepwork N?Y:j‘fﬂl;; Slettmgrj such as SMMF and LDAR
used by the

System Status -

Power: Oon Security

System state:  OS booted

Configure security protocols such as SSL and
S5H

View & summary of the current configuration

IMM Configuration k settings

| System Information H Power Actions = ‘ \ Remote Control. .. | | Latest OS Failur

Restart the IMM. Typically only needed when

Restart IMM experiencing problems with the (MM

Active Events

Severity ~  Source Date Message Sets all current configuration settings back o
- Reset IMM to factory defaults. .. defaultvaluss

Hardware Health Activation Key Management 219 370 remone activalion keys for adiional
Component Type Status functionality

Processors Normal

Memory Normal

System & Normal

3. From the Manage the IMM Configuration panel, click Backup.

4. Enter a password that is used to encrypt the backup on the Backup
Configuration panel.

IBM Integrated Management Module Il

Backup. = Backup/Restore Status.. Reset IMM to factory defaults. Initial Setup Wizard

Configuration Summary

IMM Information
Na Backup Configuration x
Ma
Cortact contact Enter a password that will be used to encrypt values in the file. Note that you will be
|ocation asked for this password when you use the file to restore a configuration.
Password:

Confirm Password:

Continue || Cancel |

1,440 minutes

Enabled

After filling in (and confirming) the password, click Continue.
5. Press and hold the Ctrl key to display the Save dialog
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Opening imm_backup El

You have chosen to open:
imm_backup

which is a! application/download (7.7 KB)
from: https:/}9.42.204.110

—hat should Firefox do with this file?

" Qpen with Browse. . |

+ i Save File

™ Do this automatically For files like this Fram now on.

Ik I Cancel

6. Save the file on your system until you can add it to the archive.
7. Close the confirmation dialog in the IMM graphical user interface.
8. Save the IMM configuration Web page from your Web browser.
a. If you are using Firefox, click File > Save Page As
Save the file as type Web Page, complete.

b. Compress the file (using zip or tar) the file index-console.php, and the
folder index-console.php_files. Protect the archive through encryption using
a strong passphrase.

What to do next

Repeat this process for all X-Architecture compute nodes. Then, you can copy the
files to your archive location.

Backing up the IMM through the CLI

The command-line interface can be used to back up the IMM.
About this task

Note: It is important that you remember your FSM password, as it is required to
restore a backup.

Assume that you have set up an SFTP server as follows:

* IP address: 191.168.1.101

* User ID: backupid

¢ Password: entR3v0OUs

* Encryption Passphrase: b@ckupNOw (zero, not an uppercase o)
¢ Backup directory: /home/userid/backup

Procedure

Complete the following steps to back up the IMM configuration.
1. Using a secure protocol, such as SSH, log in to the IMM CLI interface.

2. At the system prompt, enter the following command:
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backup -f imm_backup -pp "b@ckupNOw" -ip 192.168.1.101 -u backupid -pw entR3vOUs -fd commands
where:

* -f specifies the file name to be used for the backup..

* -pp specifies a quote-delimited passphrase

* -u specifies a valid user ID for the SFTP server

* -pw specifies the password corresponding to the user ID

 -fd specifies the file name for the XML description of backup CLI commands

What to do next

Additional information about the IMM backup process and the CLI command used
to perform a backup is available in the Integrated Management Module II User’s
Guide:

lhttp:/ /www.ibm.com /support/entry /portal /docdisplay?Indocid=MIGR-5086344

Backing up operating system and user data
Use your own operating-system and user-data backup methods to back up the
operating system and user data for the X-Architecture compute node.

Consider using a solution, such as IBM Tivoli® Storage Manager to back up
operating system and user data for X-Architecture compute nodes. Most
information about Tivoli Storage Manager is available at the following website:

fwww.ibm.com /software /products/us/en/tivostormana /|

Backing up Power Systems compute nodes
When you back up the Power Systems™ compute nodes, create backups in phases.

Back up the Power Systems profile configuration

Create a backup of the profile data for all virtual servers using the IBM FSM Web
interface. Profile data include all the virtual server profiles and virtual server
definitions within the system.

About this task

When you perform a back up, it is written to the IBM FSM and then backed up as
part FSM backup process.

Procedure
1. From the Home page, click the Chassis Manager tab.

2. On the Chassis Manager tab, right-click the Power Systems compute node to be
backed up and click System Configuration.

3. Click Manage Virtual Server Data and then click Backup
4. Choose a file name based on your backup file name guidelines and click OK.

Backing up VIOS

Backup up VIOS is essential to later recover defined virtual devices, such as disks
and networks.

VIOS can be backed up using either the backupios or viesbr command.
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Backing up Power Systems compute nodes using backupios:

The backupios command will backup all the information required to completely
rebuild a VIOS server.

Make sure that you also back up the following components (these will be needed
for the successful recovery of VIOS.

* External device configuration, such as SAN devices (V7000) and network
switches.

* Resources defined on the IBM Flex System Manager management software,
such as processor and memory allocations.

* The operating systems and applications running in the client virtual servers.
These backups should be done via script in cron and the image should be backed
up to an external device via TSM client on VIOS. Other backup options include

backing up to DVDs or to a NIM server.

Additional information

For more information, see packupios command| and [Backing up the VIOS]

Backing up Power Systems compute nodes using viosbr:

The viosbr command backs up user defined virtual devices, which is useful for
restoring information on the same VIOS from which is it is backed up

The backup will include the following:

* Logical devices, such as storage pools, clusters (VIOS Version 2.2.0.11, Fix Pack
24, Service Pack 1, or later), file-backed storage pools, the virtual media
repository, and paging space devices.

e Virtual devices, such as Etherchannel, shared Ethernet adapter, virtual server
adapters, and virtual Fibre Channel adapters.

* Device attributes for devices like disks, optical devices, tape devices, fscsi
controllers, Ethernet adapters, Ethernet interfaces, and logical Host Ethernet
Adapters.

Before you begin

Before you start, run the isolevel command to verify that the VIOS is at version
2.1.2.0, or later.

You can use following command from cron to create a backup of the configuration:
vioshr -backup -file /home/padmin/backup

The created backup file should be stored on external device using TSM, or DVD or
NIM Sever.

Additional information

For more information, see [viosbr command}

Backing up user data
Use your own operating-system and user-data backup methods to back up the
operating system and user data for the Power Systems compute node.
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Consider using a solution, such as IBM Tivoli Storage Manager to back up
operating system and user data for Power Systems compute nodes. Most
information about Tivoli Storage Manager is available at the following website:

fwww.ibm.com /software /products/us/en/tivostormana /|

Backing up the IBM Flex System V7000 storage node

The same procedures apply for backing up the Storwize® V7000 and the V7000
storage node.

It is recommended that a backup be performed after any significant changes in
configuration have been made to the system.

Note: The system automatically creates a backup of the configuration data each
day at 1 a.m. This is known as a cron backup and is written to
/dumps/svc.config.cron.xml_serial# on the configuration node.

A manual backup can be generated at any time using the instructions in this
procedure. If a severe failure occurs, both the configuration of the system and
application data may be lost. The backup of the configuration data can be used to
restore the system configuration to the exact state it was in before the failure.

In some cases, it may be possible to automatically recover the application data.
This can be attempted via the <Recover System Procedure>, also known as a Tier 3
(T3) procedure. Restoring the system configuration without attempting to recover
the application data is performed via the <Restoring the System Configuration>
procedure, also known as a Tier 4 (T4) recovery. Both of these procedures require a
recent backup of the configuration data.

Backup of the V7000 is similar to the switch backups—one command is used to
back up and another to restore.

It is recommended that you keep the automatic backup that runs each day in order
to provide an extra measure of protection.

This file has a separate (but similar) naming format as the user or automation
triggered backups, so there should be little confusion around this.

Follow these steps to perform the backup procedure.
1. svcconfig backup

2. Review backups in /dumps on your V7000 configuration node canister. There
should have been three files created by the previous command. They all start
with svc.config.backup and end with .sh_serial#, .xml_serial#, and
“.log_serial#. The XML file is the configration backup. The log file includes
any warnings and messages and the .sh file contains the commands issued to
generate the backup. You may notice another configuration backup file with the
name cron in it. That is the nightly backup that is taken automatically.

3. Transfer the backup data to backup location described at the start of this
document using scp, as follows from the V7000 CLI: pscp
superuser@cluster_ip :/dumps/svc.config.backup.* /FSM_IP/
MyBackupUserDirectory

Backing up I/O modules

The topics in this section provide information on how to back up I/O modules.
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Backing up SAN switches
Each supplier has a different procedure used to back up SAN switches.

To back up a SAN switch, use the direct switch interface to copy the configuration
file from the switch to another location.

Backing up Ethernet switches
Each supplier has a different procedure used to back up Ethernet switches.

To back up an Ethernet switch, use the direct switch interface to copy the
configuration file from the switch to another location.

Backing up top-of-rack switches

The network switches in the IBM PureFlex are BNT® (BladeNetwork Technologies,
an IBM Company) brand switches.

Models 8052 and G8264 both use the same operating system, so they can be
backed up the same way.

Before you begin, decide whether you plan to hardcode the switch user and
password in a very simple script or to set up SSH Authentication Keys for use
with your simple script.

SSH Keys are the recommended method, but you may also script using the
password and username. The examples below assume that you are using the SSH
key with Default Name for Authentication. The following steps assume that you
have created a short shell script to redirect the data into a flat file (plain text.) The
contents of the file should look something like this:

#!/usr/bin/ksh
ssh admin@hostname.or.ip.address terminal 0;enable;copy running-config backup-config;show backup-config > admin@ho
ssh admin@hostname.or.ip.address terminal 0;show version > hostname.or.ip.address.ver

1. Create a Script to redirect the data and place it in the OS (sample above) as text
files.

a. SSH into the switch

Set the terminal length to unlimited (0)

Enable EXEC/Privileged Mode

Copy the Running Configuration to the Backup Configuration

® oo o

Show the Backup Configuration; the redirection shown in the sample script
above will save the output of the show Backup Configuration.

SSH into the switch

Set your terminal length to unlimited (0)

—h

- @

Show the version; the redirection shown in the sample script above will
save the output of the show version.

As shown in the sample script, it is recommended that you save the version
information, as it is useful in the event of failure.
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Chapter 3. Restoring the IBM FSM

This section contains procedures for restoring numerous parts of the IBM Flex and
IBM PureFlex systems.

Restoring and version compatibility

Make sure that you understand the version restrictions for backup images before
you restore a backup image.

In most situations that require you to restore a backup of the IBM® Flex System
Manager management software, make sure that the management software version
in the backup file matches the management software version that you use to
restore the backup. The following guidelines show the compatible backups for each
management software version.

* With version 1.3.0, you can restore only a backup of version 1.3.0 or version 1.2.1
* With version 1.2.1, you can restore only a backup of version 1.2.1
* With version 1.2.0, you can restore only a backup of version 1.2.0
* With version 1.1.1, you can restore only a backup of version 1.1.1
* With version 1.1.0, you can restore only a backup of version 1.1.0

You cannot restore a backup image from management software version 1.1.1 or
earlier on an IBM Flex System Manager management node with management
software version 1.2.0 installed. If you must restore an image from version 1.1.1 or
earlier, use the IBM Flex System Manager management software Recovery DVDs
for the management software version that you want to restore. For more
information about using the Recovery DVDs, see the information in
lsoftware recovery and reinstallation}

If you want to restore from a backup image that is stored locally on the
management node hard disk drive, make sure that you use the Recovery DVDs for
version 1.1.1 and not version 1.1.0. A problem with version 1.1.0 requires that you
noted the local backup image name before performing the recovery. With version
1.1.1, you can use the command-line interface (CLI) to list the local backups; then,
you can restore the local backup from the CLI. For more information about
restoring an earlier version of the management software, see[Restoring an earlier
(version of the management software image]

Restoring the management software image

You can restore an IBM® Flex System Manager management software image from a
backup that is stored on the management node hard disk drive, USB drive, or a
secure FTP server (SFTP).

Important: Recovery from the DVDs is a last resort, to be used only if the service
partition does not hold the original image. In normal scenarios, the service
partition contains the factory image. The only exception is if you have consciously
ordered the recovery DVDs and manually updated the service partition. This is not
normally recommended.
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Preparing to restore a backup image

You cannot restore a backup image from management software version 1.1.1 or
earlier on an IBM Flex System Manager management node with management
software version 1.2.0 installed. If you must restore an image from version 1.1.1 or
earlier, use the IBM Flex System Manager management software Recovery DVDs
for the management software version that you want to restore.

Before you restore a backup image, make sure that you understand the following
conditions.

Configuring the management software after you restore a backup
image

After a restore operation is complete, collect inventory for all of the managed
resources in your IBM Flex System environment.

If you restored a backup that was taken from an earlier version of the management
software, update the management software to the same version as before the
restore operation.

Important: If you do not update the management software in this situation, the
management software version might be older than other components in your
environment, which might cause compatibility problems.

If any managed resources were removed from management after a backup was
created, and you restore that backup image, the endpoints for the deleted resources
will reappear in the management software. You must delete the endpoints
manually to remove them.

Similarly, any managed resources that were discovered after a backup image was
created must be re-discovered after that backup is restored.

If a chassis was managed in centralized user management mode, and you restore a
backup image that was created before centralized user management mode was
enabled, you might have to use the RECOVERY_ID account to re-manage the
chassis. For more information, see [Recovering chassis management with a CMM|
lafter a management node failure)

Further information

For detailed instructions on how to restore backups from supported sources, see
the [information center| The information center provides procedures for:

* |Restoring a management software image from the hard disk drive|

* |Restoring a management software image from a USB drive

* |Restoring the management software image from a secure FTP server|

* [Restoring an earlier version of the management software image|

Restoring chassis components

26

The topics in this section provide procedures for restoring chassis components.
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Restoring the Chassis Management Module (CMM)

The CMM can be restored through the CMM web interface, or it can be restored
using the command-line interface (CLI) of the CMM.

Restoring the CMM through the GUI
Use the CMM's native interface to restore the CMM through the GUL

Procedure

See [Restoring a CMM configuration| for the steps in the procedure.

Restoring the CMM through the CLI
Use the CMM CLI read command to restore a CMM configuration through the
CMM CLL

About this task

Note: By default, the CMM operates in secure mode. When the CMM is set to
secure, only the secure file transfer methods HTTPS and SFTP can be used for
firmware updates and other tasks involving file transfers, such as transferring a
backup configuration file to restore a configuration. The unsecure file transfer
protocols HTTP, FTP, and TFIP are disabled.

Assume that you have set up an SFTP server as follows:

* IP adress: 191.168.1.101

e User ID: userid

¢ Password: xxxxxoxoxxx

* Encryption Passphrase: b@ckupNOw (zero, not an uppercase o)
* Backup file: /home/userid/backup/cmmp.bkp

Also assume that you previously created a backup using the procedure in
fup the CMM through the CLI” on page 16|

You are restoring the backup to the primary CMM.
Procedure

Complete the following steps to restore the CMM configuration.

1. Using a secure protocol, such as SSH, log in to the CMM CLI interface using a
user ID that has Supervisor or Chassis Configuration authority.

2. At the system> prompt, enter the following command:
read -u sftp://userid:xxxxxxxx@192.168.1.101/home/userid/backup/cmmp.bkp -p "b@ckupNOw" -v
where:

* -u specifies the remote location to which the file will be written.

Note: You must enter the full destination path for the SFTP server in the
URL that you provide.

* -p specifies a quote-delimited passphrase (between 6 and 31 characters)
If successful, the system responds with:
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0K
Configuration restore was successful

Restart the MM for the new settings to take effect
What to do next
Restart the CMM to apply the settings.

To restart the CMM from the CLI, enter the following command:
reset -o

You will lose connectivity through the SSH while the CMM is being restarted.

Additional information about the CMM restoration process and the CLI command
used to restore a CMM configuration from a backup:

* Restoring a CMM Configuration

http:/ /publib.boulder.ibm.com /infocenter/flexsys/information/index.jsp?topic=]
%2Fcom.ibm.acc.cmm.doc%2Frestore_saved_config_cmm.html|

¢ read command

http:/ /publib.boulder.ibm.com /infocenter/flexsys/information /index.jsp?topic=]
%2Fcom.ibm.acc.cmm.doc%2Fcli_command_read.html|

Restoring X-Architecture compute nodes

To restore the service processor (IMM) for X-Architecture compute nodes, use
either the IMM graphical user interface or the command-line interface. To restore
operating system and user data, use standard restore procedures.

Restoring the IMM through the graphical user interface
Follow this procedure to restore the IMM through the graphical user interface.

Procedure

Complete the following steps to restore the IMM for an X-Architecture compute
node:

1. From a Web browser, log in to the IMM graphical user interface for the
X-Architecture compute node.

2. From the user interface, click IMM Management > IMM Configuration.
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IBM Integrated Man nt Module Il

System Status  Events »  Service and Support v

Server Management = | IMM M ement = |

IBM Flex System x240

Add System Descriptive Name. .
The System Status and Health page provides an at-a-glance overview of the operating stat

System Status -

Power: on

IMM Propertics

Users

Network

Security

Various properties and settings related to the
[

Create and modify and view user accounts, and
view group profile for active directory users.

Metwork settings such as SNMP and LDAP
used by the 1M

Configure securily protocols such as SSL and
SSH

System state: OS5 booted

Latest OS Failure

IMM Configuration

k.

View a summary of the current configuration
settings. :

| Systern Information = | | Power Actions w | | Remote Control

Active Events -

Severity «  Source Date Message

Hardware Health -

Restart IMM

Reset IMM to factory defaults.

Activation Key Management

Restart the IMM. Typically only needed when
experiencing problems with the IMM

Sets all current configuration settings back o
defaultvalues

Add and remove activation keys for additional
functionality

Component Type Status

Processors [ Normal
Memory [ Normal
System [ Normal

3. From the Manage the IMM Configuration panel, click Restore.
4. Click Select File to choose the location where the backup file resides.

IBM Integrated Management Module |l

_j System Status  Ewents = Service and Support -

Manage the IMM Configuration

Server Management -

I Managerment -

The MM weh console configuration settings can be exported to and imported from an external file, This is arirmarily for backup

purposes so that you can easily restore your confiouration if vou need to, The file created s a binary file and is only intended to

be used by this web tonsle; the file cannot .. | pectare Configuration

x

Backup. .. | |Restore. . .| |Backup/Restore St
Configuration Summary:
Configuration Settings

|5 M InfoiMarne,ocation, date, tirme )

Server Actions 59|E_EE_F_"E_

User Accounts and Alert Settings

Select the file that contains the configuration you wish to restore. You will need to
also supply the password that you specified when the configuration was exported.

MNote that restoring the IMM configuration may resultin the Web browser session
being dropped. If this occurs a new login using the restored IMM address will be
required to establish another YWeb session,

Metwork Settings ok | [ cancel |
Contact: contact
Locatiorn: location
MM Date and Time
Automatic DST update: Disablect

GMT offset:

After selecting the file, click OK.

5. Enter the Passphrase that you used when creating the backup in the File

Password field (b@ckupNOw).
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Restore Configuration

Select the file that contains the configuration you wish to restore. You will need to
also supply the password that you specified when the configuration was exported.

Miote that restoring the IMM configuration may result in the Weh browser session
being dropped. If this ocours a new login using the restored IMM address will be
required to establish ancther Web session. 3

| Select File, . |

Selected Configuration File: imm_backup{3)
I want to view the contents of this file prior to subrmitting it

File Password:

ik I_E._ancel_|

After entering the passphrase, click OK and the Restoring IMM Configuration
window shows you the progress being made during the restore process.

When the restore process has completed, the status is displayed. After viewing
the status to ensure the restore process was successsful, click Close.

What to do next

Repeat this process to restore the IMM configuration for any other X-Architecture
compute nodes.

Restoring the IMM through the CLI

Follow this procedure to restore the IMM through the command line interface.

About this task

Assume that you have set up an SFTP server as follows:

IP address: 191.168.1.101

User ID: backupid

Password: entR3v0Us

Encryption Passphrase: b@ckupNOw (zero, not an uppercase o)
Backup directory: /home/userid/backup

Procedure

Complete the following steps to restore the IMM configuration.

1.
2.

Using a secure protocol, such as SSH, log in to the IMM CLI interface.

At the system prompt, enter the following command:

restore -f imm_backup -pp "b@ckupNOw" -ip 192.168.1.101 -u backupid -pw entR3vOUs
where:

* -f specifies the file name used for the backup.

* -pp specifies a quote-delimited passphrase

e -ip is the IP address for the SFTP server where the backup file is located.

* -u specifies a valid user ID for the SFTP server
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* -pw specifies the password corresponding to the user ID
What to do next

Additional information about the IMM restore process and the CLI command used
to perform a restore is available in the Integrated Management Module 1 User’s
Guide:

lhttp:/ /www.ibm.com /support/entry /portal /docdisplay?Indocid=MIGR-5086346,

Restoring operating system and user data
Use your own operating-system and user-data restore methods to restore the
operating system and user data for the X-Architecture compute node.

Restoring Power Systems compute nodes

A number of checks must be performed before restoring Power Systems compute
nodes.

Before you begin

Make sure that you have recovered the following components before you recover
Power Systems compute nodes:

« FSM

* Switches
« CMM

* V7000

In order to recover a Power ITE in case of disaster, backups must be performed at
multiple layers. Before recovering the compute node, the FSM must be recovered
and fully functional. Recovery of switches, CIMM, V7000, and FSM are
prerequisites for compute node recovery. To ensure you have a capability to
recover a POWER ITE, all backups must be performed on a regular basis.

Restoring the Power Systems profile configuration
The Chassis Manager tab is used to restore the Power Systems profile
configuration.

Procedure
1. From the Home page, click the Chassis Manager tab.

2. On the Chassis Manager tab, right-click the Power Systems compute node to be
restored and click System Configuration.

3. Click Manage Virtual Server Data and then click Restore

4. Choose a file name to be restored and choose the appropriate restore option.
There are 3 options to choose from:
* Full restore.

The full restore option restores all profile data using your backup file only.
Profile modifications performed after the selected backup file was created
will be lost.

* Backup priority.
The backup priority option merges the stored backup file with recent profile
activity, but the backup information takes precedence. If information
conflicts, the stored backup data is restored over the recent profile activity.
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* Host priority.
The host priority option merges recent profile activity with the stored backup
file, but the recent profile activity takes preference. If information conflicts,
the recent profile activity is restored over the stored backup data.

5. Click OK to start the restore process.

Restoring VIOS

Depending on the backup taken using backupios, the restore procedure varies.

* If the backup was creating using the NIM server nimresources.tar, the restore
can be completed using the following command:

installios

Note: Run the smcli 1sbundle command to obtain a list of valid commands.

* If backup is done via mksysb image to NIM defined NIM resource and restore
the mksysb image.

Note: Before restoring VIOS, ensure that the data from external devices are
restore and available. Ex: SAN, Network

Restoring operating system and user data
Use your own operating-system and user-data restore methods to restore the
operating system and user data for the X-Architecture compute node.

Restoring the IBM Flex System V7000 storage node

The same procedures apply for restoring the Storwize V7000 and the V7000 storage
node.

Before you restore the IBM Flex System V7000 storage node, ensure that you read
the topics in this section thoroughly.

Before you start, be aware of the following:

¢ The default object names for controllers, I/O groups, and managed disks
(MDisks) do not restore correctly if the ID of the object is different from what is
recorded in the current configuration data file.

 All other objects with default names are renamed during the restore process. The
new names appear in the format name_r, where name is the name of the object in
your system.

Before you restore your configuration data, the following prerequisites must be
met:

* The Security Administrator role is associated with your user name and
password.

* A copy of your backup configuration files are available on a server that is
accessible to the system.

* A backup copy of your application data is accessible and ready to load on your
system after the restore configuration operation is complete.

* You must know the current license settings for your system.

* No hardware can have been removed since the last backup of your
configuration.

* No zoning changes were made on the Fibre Channel fabric that would prevent
communication between the Storwize V7000 and any storage controllers that are
present in the configuration.
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* For configurations with more than one I/O group, if a new system is created on
which the configuration data is to be restored, the I/O groups for the other
control enclosures must be added.

Determining how to achieve an ideal T4 recovery
Before you attempt to restore the IBM Flex System V7000 storage node, determine
the ideal method for the restoration.

Procedure

1. Open the appropriate svc.config.backup.xml (or svc.config.cron.xml) file
with a suitable text editor or browser.

2. Navigate to the node section of the file.

3. For each node entry, make a note of the value of following properties;
I0_group_id, canister_id, enclosure_serial number.

4. Use the CLI sainfo 1sservicenodes command and the data to determine which
node canisters previously belonged in each IO group.

What to do next

Restoring the system configuration must be performed via one of the nodes
previously in IO group zero. For example, property name="IO_group_id" value="0"
. The remaining enclosures must be added, as required, in the appropriate order
based on the previous IO_group_id of the node canisters.

Note: It is not possible to determine which canister within the identified enclosure
was previously used for cluster creation. Typically, the restoration should be
performed via canister 1.

The Storwize V7000 analyzes the backup configuration data file and the system to
verify that the required disk controller system nodes are available. Use this
procedure only in the following situations:

e If the recover procedure has failed

* If the data that is stored on the volumes is not required

This configuration restore procedure is designed to restore information about your
configuration, such as volumes, local Metro Mirror information, local Global Mirror
information, storage pools, and nodes. All data that you have written to the
volumes is not restored. To restore the data on the volumes, you must restore
application data from any application that uses the volumes on the clustered
system as storage separately. Therefore, you must have a backup of this data before
you follow the configuration recovery process.

You must reinstate the system to the exact state it was in before the failure, and
then recover the application data.

Important: There are two phases during the restore process: prepare and execute.
You must not change the fabric or system between these two phases. If you do not
understand the instructions to run the CLI commands, see the command-line
interface reference information.

Restoring configuration data
After you have read the prerequisites, perform these steps to restore configuration
data.
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Before you begin

Important: Ensure that you have read the prerequisite information in ['Restoring]

the IBM Flex System V7000 storage node” on page 32 and [“Determining how to|

achieve an ideal T4 recovery” on page 33[before you perform this procedure.

Procedure

1. Verify that all nodes are available as candidate nodes before you run this
recovery procedure. You must remove errors 550 or 578 to put the node in
candidate state. For all nodes that display these errors, perform the following
steps:

a.

Point your browser to the service IP address of one of the nodes, for
example, https://node_service_ip_address/service/.

b. Log on to the service assistant.

o

@ =~ o o

From the Home page, put the node into service state if it is not already in
that state.

Select Manage System.

Click Remove System Data.

Confirm that you want to remove the system data when prompted.

Exit service state from the Home page. The 550 or 578 errors are removed,
and the node appears as a candidate node.

Remove the system data for the other nodes that display a 550 or a 578
error. All nodes previously in this system must have a node status of
Candidate and have no errors listed against them.

Note: A node that is powered off might not show up in this list of nodes
for the system. Diagnose hardware problems directly on the node using
the service assistant IP address and by physically verifying the LEDs for
the hardware components.

2. Verify that all nodes are available as candidate nodes with blank system fields.
Perform the following steps on one node in each control enclosure:

a.

d.

Connect to the service assistant on either of the nodes in the control
enclosure.

Select Configure Enclosure.

Select the Reset the system ID option. Do not make any other changes on
the panel.

Click Modify to make the changes.

3. Use the initialization tool that is available on the USB flash drive to a create a
new Storwize® V7000 system. Select the Initialize a new Storwize V7000
(block system only) option from the Welcome panel of the initialization tool.

4. In a supported browser, enter the IP address that you used to initialize the
system and the default superuser password (password).

5. At this point the setup wizard is shown. Complete these steps:

a.
b.

C.

Accept the license agreements.

Set the values for the system name, date and time settings, and the system
licensing. The original settings are restored during the configuration
restore process.

Verify the hardware. Only the control enclosure on which the clustered
system was created and directly attached expansion enclosures are
displayed. Any other control enclosures and expansion enclosures in other
I/0 groups will be added to the system.
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10.

11.

12.

13.

d. On the Configure Storage panel, clear the Yes automatically configure
internal storage now option. Any internal storage configuration is
recovered after the system is restored.

Optional: From the management GUI, click Access > Users and configure an
SSH key for the superuser.

By default, the newly initialized system is created in the storage layer. The
layer of the system is not restored automatically from the configuration
backup XML file, so if the system you are restoring was previously configured
in the replication layer, you must change the layer manually now. For more
information, refer to Metro Mirror and Global Mirror partnerships.

For configurations with more than one I/O group add the rest of the control
enclosures into the clustered system.

a. From the management GUI, select Monitoring > System Details.
b. Select the system name in the tree.

c. Go to Actions > Add Enclosures > Control and Expansions.

d

. Continue to follow the on-screen instructions to add the control enclosures.
Decline the offer to configure storage for the new enclosures when asked if
you want to do so.

Identify the configuration backup file from which you want to restore. The file
can be either a local copy of the configuration backup XML file that you saved
when backing up the configuration or an up-to-date file on one of the nodes.
Configuration data is automatically backed up daily at 01:00 system time on
the configuration node. Download and check the configuration backup files on
all nodes that were previously in the system to identify the one containing the
most recent complete backup. For each node in the system:

a. From the management GUI, click Settings > Support.

Click Show full log listing.

Select the node to operate on from the selection box at the top of the table.
Find the file name that begins with svc.config.cron.xml.

Double-click the file to download the file to your computer. The XML files
contain a date and time that can be used to identify the most recent
backup. After you identify the backup XML file that is to be used when
you restore the system, rename the file to svc.config.backup.xml.

® oo o

ssue the following CLI command to remove all of the existing backup and
restore configuration files that are located on your configuration node in the
/tmp directory: svcconfig clear -all

Copy the XML backup file that you wish to restore from back onto the system.
pscp full_path_to_identified_svc.config.backup.xml
superuser@cluster_ip:/tmp/

Issue the following CLI command to compare the current configuration with
the backup configuration data file: svcconfig restore -prepare This CLI
command creates a log file in the /tmp directory of the configuration node.
The name of the log file is svc.config.restore.prepare.log

Note: It can take up to a minute for each 256-MDisk batch to be discovered. If
you receive error message CMMVC6200W for an MDisk after you enter this
command, all of the managed disks (MDisks) might not have been discovered
yet. Allow a suitable time to elapse and try the svcconfig restore -prepare
command again.

Issue the following command to copy the log file to another server that is
accessible to the system: pscp superuser@cluster_ip:/tmp/
svc.config.restore.prepare.log full_path_for_where_to_copy log_files
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14. Open the log file from the server where the copy is now stored.
15. Check the log file for errors.

* If there are errors, correct the condition that caused the errors and reissue
the command. You must correct all errors before you can proceed to the
next step.

 If an error indicates that the system layer will not be restored, then return
to step 7, configure the layer setting correctly, and then continue the restore
process from step 10.

« If you need assistance, contact the IBM® Support Center.

16. Issue the following CLI command to restore the configuration: svcconfig
restore -execute This CLI command creates a log file in the /tmp directory of
the configuration node. The name of the log file is
svc.config.restore.execute.log.

17. Issue the following command to copy the log file to another server that is
accessible to the system: pscp superuser@cluster_ip:/tmp/
svc.config.restore.execute.log full_path_for_where_to_copy_log_files

18. Open the log file from the server where the copy is now stored.

19. Check the log file to ensure that no errors or warnings have occurred.

Note: You might receive a warning stating that a licensed feature is not
enabled. This message means that after the recovery process, the current
license settings do not match the previous license settings. The recovery
process continues normally and you can enter the correct license settings in
the management GUI at a later time. When you log into the CLI again over
SSH, you see this output: IBM_2076:your_cluster_name:superuser

20. After the configuration is restored, verify that the quorum disks are restored
to the MDisks that you want by using the 1squorum command. To restore the
quorum disks to the correct MDisks, issue the appropriate chquorum CLI
commands.

What to do next

You can remove any unwanted configuration backup and restore files from the
/tmp directory on your configuration by issuing the following CLI command:
svcconfig clear -all.

Restoring I1/0 modules

The topics in this section provide information on how to restore I/O modules.

Restoring SAN switches
Each supplier has a different procedure used to restore SAN switches.

To restore a SAN switch, use the direct switch interface to copy the configuration
file from its backup location to the switch.

Restore FC3171 SAN switch (QLogic)

User credentials are not stored in the backup file. Users must reconfigure it after
restore.
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Restore FC5022 SAN switch (Brocade)

Restore configuration is as follows:

Restoring Ethernet switches
Each supplier has a different procedure used to restore Ethernet switches.

To restore an Ethernet switch, use the direct switch interface to copy the
configuration file from its backup location to the switch.

Restoring Ethernet chassis switch (EN4093)

The switch must be in the same CLI mode (IBMNOS/ISCLI/prompted) for backup
and restore. Otherwise, the restore will fail.

Note: If EN4093 is configured in ISCLI mode, the deployment of EVB profile via
FSM will fail. The deployment only works with IBMNOS or prompted mode.
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Restoring up top-of-rack switches

To restore simply copy and paste the configuration commands.

Important: In order for the commands to paste accurately, you must default the
switch to factory settings and perform the copy and paste action from there.

The copy and paste of the configuration commands will work in all environments.
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Chapter 4. Validating a system restore

IBM provides additional documentation that will assist you in validating a system
restore.

See the [firmware updates best practices guides)
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